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Photoshop kullanıcılarının en iyi bilmesi gereken konu, bana göre bir seviye 
belirleme niteliği taşıyan seçim teknikleridir. Photoshop üzerinde de bu 
konu oldukça fazla araçla zenginleştirilmiş hazırlanmıştır. 

SEÇEMEZSEN YAPAMAZSIN
SEÇİM ARAÇLARI

Kullanıcıların kendi arasında yaptığı tar-
tışma ve yazışmalarda seçim işlemlerine 
dair birçok soru ve soruna rastlıyoruz. 

Tüm çalışmalarda belirleyici olan bir faktör 
vardır, hazırlık. Hazırlık aşama ve işlemleri her 
ne iş için yapılıyorsa ara işlemler eksiksizce 
tamamlanmalıdır. Ben de bu gözle seçim 
işlemlerine dair bilgilerimi buradan sizlerle 
paylaşarak bilgi akış zincirini devam ettirmek 
istiyorum. Sizler de öğrendiklerinizi ilgili yer-
lerde paylaşırsanız, tartışılan bilgi, kullanılan 
bilgi, sınanan bilgi gelişir, detaylanır ve başka 
bilgilerin, deneyimlerin kazanılmasında belir-
leyici olur. Biz buna inanıyoruz, bu çok sözü 

edilen ama bir o kadar da çok az örnekleri 
olan bir konu. Tüm bilgilerde olduğu gibi sa-
hip olan hiç bir bilgi temelsiz, durduk yerde 
bir kişide oluşmaz. Elimden geldiğince önem 
verdiğim yayın evlerinin Photoshop konulu 
tüm kitaplarını alır, ilgili sayfalarını incelerim. 
Sahip olunan bilgi hangi düzeyde olursa ol-
sun bilgilerin güncelleştirilmesine inanınırım.

Seçim İşlemleri
Bu sayıda okuduğunuz Mask’lar hakkında 
tanımlama yaparken belirli bölgeleri sınırla-
yarak, etkinin istediğimiz noktalarda gerçek-
leşmesine yardımcı olur demiştik. Seçimler 
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Mask işlemlerinden önce, ister bir noktaya 
renk doldurmak, ister belirlediğimiz bir çerçe-
vede yapılacak efekt, renk uygulaması, silme, 
kopyalama gibi özel işlemlerde belirleyici bir 
konudur. Bu yönüyle seçim işlemleri de bir 
maskeleme türüdür. Seçim işlemlerini tümüyle 
amaca yönelik tanımlamak ve kullanmak gerek-

lidir. Çünkü, seçim işlemleri 
ilk bakışta çok sıradan bir 
fonksiyon olarak görünse 
de çalışma sürecini zaman 
olarak uzatabildiği gibi kı-
saltabilir de. Birçok forumda 
tartışılan saç dekubesi ya 
da buna benzer klasik yön-
temlerle seçimi çok zor ve 
zaman alan seçim işlemleri 
için yine klasik yöntemlerin 
dışına çıkılması gereklidir. Bu 
seçim işlemlerinde hazırlık 
süreci sonucu direkt olarak 
etkileyeceğinden düşünsel 
ön hazırlık yaparak işe baş-
lanılmalıdır. Rastgele atışlar 
ender tesadüflerin dışında 
sizleri başarıya ulaştırmaz.

SEÇİM ARAÇLARI
Bu başlık bir çoğunuza ta-
nıdık ve bildik görünebilir. 
Ama konunun bütünlüğü 
açısından işi en temelin-
den alarak derinleştirmek 
istiyorum. Photoshop’un 
Toolbox araçları arasında 
en fazla sayıya sahip araç 
türlerinden biri de seçim 
araçlarıdır. Seçim işlemleri 
için farklı özelliklerde bu 
denli fazla ve alternatifli araç-

ların olması bu işin önemini göstermektedir. 
Bu alternatifler içinde sunulan tüm araçların 
kullanım biçimlerini, işin mantığını gözeterek 
öğrenmeli ve kullanmalıyız. 

Yapılan işlemler birbirine benzeyebilir, ba-
zen bir işlemi yakın sonuçlar yakalayarak farklı 
araç ve yollarla da yapabiliriz. Bunda bir ters-
lik yoktur. Photoshop’ta doğru ve yanlış ol-
madığına inanıyorum. Doğrularımız ve yan-
lışlarımız yaptığımız işin neticesine göre de-
ğişir ve Photoshop dünyasında önemli olan 
sonuçtur. Müşterileriniz veya yaptığınız işi sa-
tın alan kişiler bunu nasıl yaptığınızdan çok 
çıkan sonucun başarısıyla ilgilenirler. 

Bu noktada Photoshop’un kullanım tek-
nikleri, özel püfleri bu denli çok ve dünya-
nın en fazla konuşulan yazılımlarından biridir. 
Seçim işlemlerinin kullanım alanlarını  keskin 
çizgilerle çizemeyiz. Yalnız kullanım amacına 
yönelik seçim işlemlerinin tanımını yapabiliriz. 
Bu doğrultuda; uygulanacak etkinin (boyama, 
efekt, silme, kopyalama) istediğimiz, ön gördü-
ğümüz pikseller üzerinde olması için, o böl-

geyi sınırlamak amacıyla, Photoshop’un araç 
ve özelliklerini kullanarak planlanan işlemlerin 
gerçekleştirilmesi tanımını yapabiliriz. Bu ta-
nıma eklemeler yapılabilir ve yoruma açıktır. 

Photoshop tüm çalışmalarınızda sizlerden 
özel bir komut bekler. Uygulanacak etkinin 
nereye ve nasıl olacağı konusunda mutlak bir 
direktife ihtiyaç duyar. Eğer çalışmada özel bir 
seçim aktif değilse, Photoshop uygulayacağı 
etkiyi tüm çalışma alanına, katman veya ka-
nallara uygular. Eğer herhangi bir seçim ara-
cıyla yapılmış bir aktif seçim alanı varsa etki 
bu seçim alanı içindeki piksellere uygulanır. 
Yapılacak işin niteliği ve zaman olarak uzun-
luğu birçok noktada bu seçim işlemlerinin 
kalitesiyle direkt orantılıdır. 

Genel bütünlük içindeki seçim işlemlerinin 
hangi araç, yol ve yöntemlerle yapılacağının 
kararı rastgele alınmamalı, üzerinde küçük-
de olsa bir ön hazırlık yapmalıyız. Bu çalışma 
alışkanlıkları zamanla gelişen, size özgü çalış-
ma prensipleriyle bilginizi artıracaktır. Bunu 
çok basit bir örnekle de anlatmak istiyorum. 

Dairelerden oluşan bir çalışmada, mavi 
renkli daireleri seçebilmek için kaç farklı yol 
geliştirebiliriz. İlk akla gelen MagicWend ara-
cını kullanarak renge duyarlı bir seçimin ar-
dından, Select menüsünü kullanarak Smilar 
komutunu kullanmak. Başka bir yol, Select> 
ColorRange’i kullanmak. MagicWend aracı kul-
lanarak farklı yollardan gidilerek de aynı se-
çim gerçekleştirilebilir. Photoshop dünyasın-
da daha önce söylediğimiz gibi tek bir yol ve 
tek bir doğru yoktur. Seçim işlemlerinde özel-
likle karmaşık ve normal Toolbox araçlarıyla 
yola çıktığımız saatler alabilecek bazı seçim 
işlemleri, alternatif yollar denendiğinde çok 
daha kısa sürebilir. Bu alternatif yollara Alp-
ha kanallarını örnek gösterebilirim. 

COLAR RANGE renge duyarlı seçimlerde ba-
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PATH ARAÇLARI

Dekube amaçlı ya da başka bir progra-
ma  arka planın saydam aktarılması sırasın-
da kullanılır. 

MARQUE ARAÇLARI

Kare, elips şeklinde aktif seçim alanları oluş-
turan, sıklıkla kullanılan seçim araç grupları.

LASSO ARAÇLARI

Serbest seçim yapmak istediğinizde, var 
olan seçim alanı üzerinde düzenleme yap-
mak istediğinizde bu araçları kullanabilirsiniz. 

SELECTION ARAÇLARI

Path ve Shape şekilleri üzerinde düzenle-
me yapabileceğiniz araç seçenekleri.
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şarıyla kullanabileceğiniz Photoshop’un Magic 
Wend aracının başka bir versiyonu. Select> 
Color Range menüsünden ulaşabileceğiniz 
uygulamayı açtığınızda, seçmek istediğiniz 
renkleri belirlemeye yarayan damlalıklarla 
işe başlayabilirsiniz. Uygulama penceresinde 
bulunan 3 ayrı damlalıktan, soldaki ana rengi 
belirlemek için, ortadaki (+) belirlenen ana 
renge yakın seçilmeyen renkleri seçime dahil 
etmek için, sağdaki (-) seçilen renkler arasında 
seçimden çıkarmak istediğimiz tonlar olması 
durumunda üzerlerine tıklayarak seçimden 
çıkarmak için kullanabilirsiniz. Fuzziness  sür-
güsüde seçimin tölerans değerlerini, hassa-
siyetini kontrol etmek için kullanabilirsiniz.

Seçim araçları kullanılarak yapılabilecek 
işlemler aslında çok basittir ama detayların 
doğru ve sağlıklı seçilmesi, seçimlerin içinde-
ki piksellerin taşınması ve seçilmiş alana mü-
dahale noktasında işin iyi yapılıp yapılmadı-
ğı ortaya çıkar. 

Bu noktada seçim işlemleri sırasında 
Photoshop’un birçok fonksiyonunu kullan-
mak gerekebilir. Buna örnek vermek gere-
kirse, MagicWend ile yapılan seçimlerin hat-
ları renkli piksellerden dolayı düz değil, girin-
tili çıkıntılı bir görünüme sahiptir. Bu hatların 
düzleştirilmesi için Select menüsündeki Smo-
oth, Expand, Contract kullanılabilir. 

Örnek görsel üzerinde açık renkle gösteril-
miş noktaları her iki görsel üzerinde karşılaştı-

rın. Sağda bulunan görsele 5 piksellik Smooth 
uygulandı. Uygulama sonrasındaki değişimi 
gözlemleyebilirsiniz. Başka bir örnek vermek 
gerekirse MagicWend ya da renge duyarlı bir 
seçim yaptıktan sonra oluşan seçim alanını 
içindeki piksellerle birlikte taşıdığınızda saçak 

dediğimiz taşınan piksellerin kenarlarında, ilk 
taşındığı yerden kalan farklı renklerde pikseller 
görünebilir. Bunun da giderilmesinde Matting 
fonksiyonu kullanılabilir ya da seçim alanı 1 
piksel içe daraltılarak işlem yapılması bu so-
runu ortadan kaldırmada bir önlem olabilir. 

Çalışmanız sırasında Pen Tool araçlarının 
dışında yaptığınız seçimler, siz onları tekrar 
kullanmak için kaydetmediğiniz sürece kalı-
cı olmazlar. Seçimleri saklamanın en iyi yolu 
Alpha kanallarıdır. Alpha kanalları hakkında bu 
özel sayıda yazdığım bilgilere bakabilirsiniz, 
orada siyah ve beyaz renklerin seçim işlemle-
rinde de kullanıldığını söylemiştim. Çalışma-
nızda var olan bir seçimi daha sonra tekrar 
kullanabilmek için Select menüsünden Save 
Selection komutunu kullanarak Alpha kanalına 
tercih ettiğiniz bir isimde kaydedebilirsiniz. 
Kaydettiğiniz seçimleri tekrar kullanabilmek 
için aynı menüden Load Selection komutunu 
seçebilirsiniz. Alpha kanallarına kaydettiğiniz 
seçimler aktif selection konumundan çıkmış 
siyah, beyaz piksellerle ifade edilen bir yapıya 
dönüşmüştür. 

Seçimlerin tekrar kullanımında çok fazla 

göze çarpmayan bir komut vardır. Select 
menüsü altında bulunan ReSelect komutu, 
seçimi iptal ettiğinizde, kaldırdığınızda baş-
ka bir işlem yapsanız dahi, Select> Reselect 
komutuyla en son aktif olan seçimi yeniden 
aktif duruma getirebilirsiniz. Bu bir geri alma 
işlemiyle karıştırılmamalıdır.

SEÇİM ARAÇLARI VE ÖZELLİKLERİ
Mask’ları salt geçiş ve kompozit efekt üreti-
mindeki rolleriyle ele alamayız. Mask’lar kulla-
nım ve hazırlık süreçleriyle Photoshop’un çok 
önemli bir noktasında görev alırlar. Mask’ları 
verimli kullanabilmek için Layer’ları, seçim 
tekniklerini, kanalları biliyor olmak gerekir ve 
Mask’lar bunların üzerinde yer alır. Anlamak 
ve çalışmalarınızda yorumlamak için de orta 
düzey Photoshop bilgisine ihtiyacınız vardır.

MARQUEE SEÇİM ARAÇLARI
Rectangular, Eliptical, Single Row ve Column 
araçlarından oluşur. Single Row ve Column’un 
kullanım oranı çok düşüktür. Photoshop’un 
özellik barı Toolbox araçlarından hangisi se-
çilmiş ise bu araca göre seçeneklerini değiş-
tirir. Bu fonksiyon ile birlikte arayüz üzerinde 
hareket etmek çok daha kolay olmuştur. Mar-
quee araçlarından Rectangular veya Elliptical’ı 
seçtiğinizde bu özellik barı üzerinde aktif olan 
seçeneklerle birlikte pratik bir kullanım kaza-
nabilirsiniz.

Bizleri her Photoshop kullanım seviyesin-
den okurlarımız takip ettiğinden, çok temel 
bir konu olsa da bu araçların kullanım özel-
liklerinde bahsetmek istiyoruz. 

Rectagunlar aracı ile, kare, dikdörtgen se-
çim alanları, Elliptical ile de yuvarlak, elips, 
dairesel seçim alanları oluşturabilirsiniz. Her 
iki seçim aracında kullanabileceğiniz bazı klav-
ye kısa yolları mevcuttur. Klavyeden “Shift” 
tuşuna basarak oluşturduğunuz Rectangular, 
Elliptical seçim alanları matematiksel olarak 
tam kare ve tam daire özelliğini taşır. Shift 
tuşu birçok aracın kullanımında doğrusallık, 
oran, denge özelliklerinin kullanılmasında 
belirleyicidir. Shift tuşunun yanında bağımsız 
olarak Mac: “Alt”, PC “Options” tuşunun kulla-
nımı vardır. Seçim oluşturulmadan önce, fare 
imlecini bir noktaya tıklayıp, elinizi fareden 
kaldırmadan Alt/Options tuşunu basılı tutarak 
oluşturacağınız kare veya dairesel seçim ala-
nı tıkladığınız noktayı merkez kabul eder ve 
fareyi sürüklediğiniz yönde genişleyen seçim 
alanının tersi yönünde aynı oranda  seçim 
genişler. Bu işlemi Shift+Alt /Shift+Options tuş 
kombinasyonuyla gerçekleştirirseniz merkez-
den dışa doğru genişleyen seçim oranlı bir 
şekilde gerçekleşir. Bu yardımcı kısa yol tuş 
kombinasyonları çalışma alanında herhangi 
bir seçim alanı olmaması durumunda geçerli-
dir. Özellik barında bulunan seçim işlemleriyle 
birlikte kullanılan seçenekleri inceleyelim.

Feather; Photoshop’un eski sürümlerinde, 
seçim oluşturulduktan sonra aktif seçim alanı-
na uygulanabilen Feather, seçim alanı içinde 
yapılabilecek etkiler sonucunda seçimin kenar 
hatlarında belirgin iz, kontur gibi gözü rahatsız 
edecek sonuçlarla karşılaşmamak gibi çeşitli 

SEÇİM TEKNİKLERİ 
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işler için kullanılan eski bir özelliktir. Özellik ba-
rına gireceğiniz ön Feather değerinden sonra 
Rectangular/Elliptical seçim araçlarıyla oluştu-
ran seçimlere direkt Feather uygulanmış olur.

Style; Normal, Fixed Aspect Ratio, Fixed 
Size olmak üzere 3 fonksiyon seçeneğinden 
oluşmaktadır. İlki olan Normal seçeneğinde; 
Rectangular/Elliptical seçim araçlarını serbest 
olarak kullanabiliyorsunuz. 

Fixed Aspect Ratio; Width ve Height 
kutucuklarına yazacağınız 1/2 veya 3/1 gibi 
oranlarla seçimin genişlik ve boy ölçüsünü 
birbirine oranlayabilirsiniz. Bu oranları kulla-
nırken seçiminiz kısıtlanmış olur. 

Fixed Size; Rectangular ya da Elliptical 

seçim araçlarını kullanarak belirli ölçülerde 
seçim alanları oluşturmak istediğinizde Fixed 
Size’ı kullanabilirsiniz. Bir seçim oluştururken 
seçimin genişlik ve yükseklik değerini Info pa-
letinden kontrol edebilirsiniz.

Tool Presets; Bir çalışmada içinde olabile-
ceği gibi sürekli  benzer ölçülerde hatta bazıla-
rını sıklıkla kullandığınız seçim alan ölçüleriniz 
olduğunuzu düşünelim. Bunları her seferinde 
tek tek ayarlamak size zaman kaybettirebilir. 

Toolbox üzerinde ön değer girilen tüm 
araçlarla birlikte çalışan pratik bir kullanımı 
olan Tool Presets birçok kullanıcının gözün-
den kaçırdığı bir fonksiyondur. Sıklıkla kullan-
dığınız bazı değerlerindeki toolbox araçları 

için tekrar tekrar aynı ya da benzer değerleri 
girmemek için ön değerlerden oluşan araç 
özelliklerin bir yere kaydedip, kısa aralıklarla 
farklı tercihlerde aynı aracı kullanmak istedi-
ğinizde değerleri tekrar girmenize gerek kal-
madan listeden seçip tüm ayarların yapılmış 
ve kullanıma hazır halde olmasını amaçlayan 
bir fonksiyondur. 

Kullanımı oldukça basit olan Tool Presets 
için ön değerlerden oluşan bir kütüphane 
yapmak için, Rectangular ya da Elliptical 
araçlarından birini seçin. Feather değeri de 
girebilirsiniz. Style sekmesinden istediğiniz 

bir uygulamayı seçin. İstediğiniz ölçülerde 
oluşturacağınız ön değerlerden oluşan se-
çim bilgisini hiç oluşturmadan direkt Tool 
Presets options sekmesinden “New tool Pre-
sets” komutunu verin. Açılan isim penceresini 
kullanarak, uygun bir isim verin ve onayla-
yarak kapatın. Yeni kaydınız listede hemen 
görünecektir.

Tool Presets aracını brush, healing brush, 
shape, type gibi ön değer girilen tüm araç-
ların yönetiminde yardımcı bir fonksiyon ola-
rak, MagicWend, Magnetic Lasso araçlarında 
da kullanabilirsiniz.

LASSO SEÇİM ARAÇLARI
Esnek yapısıyla, pratik ve rahat kullanımıyla 
lasso seçim araçları her işlemde vaz geçilmez 
seçeneklerden biridir. Lasso araçları daha çok 
bir seçim çalışmasında ara bir işlem, düzeltme, 
tashih seçimlerinde kullanmayı tercih ediyorum. 
Lasso araçlarının kontrolü tümüyle elle yapılır. 
Mekanik bir yönü yoktur. Az önce seçimler için 
yardımcı fonksiyonlar ile ilgili yazımda belirti-

SEÇİM TEKNİKLERİ
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Çalışmanızda aktif bir seçim alanı bulun-
ması durumunda, buna ilaveten, üze-
rinde ya da bağımsız başka bir noktada 

ikinci bir seçim alanı oluşturmak için klav-
yeden Shift tuşunu kullanabilirsiniz. Tüm 
seçim işlemleri için geçerli olan bu komu-
tun yanında var olan bir seçim alanından 
belirli bir bölgeyi seçimden çıkarmak için 
de Alt/Options tuşunu kullanırız. Eklemek is-
tediğiniz seçim için, klavyeden Shift tuşuna 
basın, herhangi bir seçim aracını kullanark 
istediğiniz noktada seçim alanı oluşturun ya 
da var olanı genişletin. Bir seçimden belirli 
bir bölgeyi çıkarmak için de klavyeden Alt/
Options tuşuna basın ve çıkarmak istediğiniz 
bölge üzerinde seçim araçlarını kullanarak bir 
alan oluşturun. Seçim alanı oluşur oluşmaz 
elinizi fareden çektiğinizde Alt/Options tuş-
larına bastığınız için oluşan seçim alanı var 
olan seçim alanından çıkartılmış olur. 

Bu işlemler için klavye tuş kombinas-
yonlarını kullanmak istemezseniz, özellik 
barında seçim araçlarından biri seçildiğinde 
kullanıma açık olan Selection grup yardımcı 

fonksiyonlarını öneririz. Bu fonksiyonlar tüm 
seçim işlemlerinde geçerlidir. Bu fonksiyon-
ların kullanım özelliklerinden bahsedelim. 

“1” ile vurguladığımız ikon “New Selection” 
fonksiyonudur. Yeni bir seçim alanı oluştur-
mak için kullanırız. Bu seçimden önce aktif 
bir seçim alanı varsa fareyle bir noktaya tık-
ladığımız anda pasifleşir ve yeni bir seçim 
alanı oluşturmak için fareyle yapacağımız 
bir hareketi bekler. 

2’ye tıkladığınızda (Add to Selection) çalış-
ma alanında seçim alanı varsa bu var olan se-
çim alanı pasifleşmez istediğiniz bir noktada 
istediğiniz kadar seçim oluşturabilirsiniz. Bu 
fonksiyon klavye tuş kombinasyanlarından 
Shift tuşuna denk gelmektedir. 

3’nolu seçenek olan Subtract fonksiyo-
nudur. Aktif bir seçim alanı içinden belirli 
bir bölgeyi seçim dışı bırakmak için klavye-
den Alt/Options tuşunu basılı tutup, seçim 
araçlarından biriyle aktif seçim alanı içinde 
kalan piksellerden bir bölümü seçip, fare-
den elinizi çektiğiniz anda tanımladığınız bu 
alan aktif seçim alanından çıkartılır. Seçim 
işlemleri üzerinde ekleme, çıkarma yaparken 
klavye tuş kombinasyonlarını kullanırken bu 
ikonlara dikkat edin. Siz onları seçmeden, 
klavyeden tuşlara bastığınız sırada (Shif, Alt/
Options) aktif fonksiyon değişir. Son olarak 
Intersect fonksiyonu: 

4’nolu Fonksiyon ortak alanı kullanmayı 
hedefler. Çalışma sistemi, aktif bir seçim alanı 
üzerinde oluşturulacak ikinci bir seçim alanı 
ile arasındaki ortak oluşan piksellerin seçili 
kalmasını sağlar. Klavye tuş kombinasyonu 
Shift+Alt/Options tuşlarıdır.

Seçim Alanlarını Kontrol Edin
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ğim seçenekler Lasso araçları içinde geçerlidir. 
Lasso araçlarından Magnetic Lasso’nun dışında 
diğer iki aracın kullanımında özel bir seçenek 
yoktur. Lasso ve Polygonal, Lasso kullanımında 
klavye tuş kombinasyonlarını kullanarak bir-
birleri arasında geçiş yapabilirsiniz. Özellikle 
Lasso aracını kullanarak farklı araçlarla yapılan 
seçim işlemleri üzerinde küçük düzenlemeler 
yapabilirsiniz. Aktif bir seçim alanı üzerinde 
klavyeden Shift tuşunu basılı tutarak aktif se-
çim alanına istediğiniz bölgeleri ekleyebilir, 
Alt/Options tuşunu kullanarak da seçimden 
alan çıkartabilirsiniz.

SELECT MENÜSÜ
Seçim işlemleri ve seçimlerin ileri düzey kul-
lanımlarını Alpha kanalları konusu altında iş-
leyeceğiz. Seçimlerin başlı başına bir menü-
ye sahip olması ve yazı içinde geçen konula-
rı açıklamak için menüyü bütün olarak açık-
lamak istedim. Menünün liste yapısını refe-
rans alarak yukarıdan aşağıya sırayla açıkla-
yalım. Bu menüye Layer seçenekleri CS 2 sü-
rümüyle birlikte geldi ve oldukça işlevsel bir 
rol üstlendiler. Bazı kullanıcılar CS 2’nin yeni 
özelliklerinden Layer’lar ile ilgili olanlarında 
başlarda sıkıntısı çektiler. El alışkanlıkları, bu 
konuda farklı tuş kombinasyonlarına, seçe-
neklerine gidiyordu çünki. Şimdilerde bu ko-
nuda çok sorun olmasada, iki katmanı bir bi-
rine bağlama, linkleme konusunda küçük bir 
bocalama olabilir.

All: Photoshop çalışma alanına bir efekt uy-
gulayacağında aktif bir seçim alanı olup olma-
masına bakar. Eğer aktif bir seçim alanı yoksa 
tercih edilen efekt tüm alana uygulanacağını 
düşünür. Bu noktada çoğu zaman Select> All 
komutuna ihtiyaç duymadan renk doldurma, 
degrade efektleri, filter uygulamaları vb. kul-
lanılabilir. All komutu açık olan tüm çalışma 
arayüzünü seçmek için kullanılır.

Deselect: Aktif seçim alanını kaldırmak 
için kullanabilirsiniz. Çalışma sırasında aktif 
bir seçim varsa, toolbox’ta yer alan seçim 
araçlarından biriyle seçimin dışına bir kere 
tıkladığınızda da seçim iptal olmuş, kaldırılmış 
olur. Aktif bir seçimi kaldırmak için, bir seçim 
aracıyla illa bir boşluğa tıklamak sıkıntılara yol 

açar, Deselect bu noktada en problemsiz ve 
hızlı çözümdür.

Reselect: Aktif olan en son seçimi iptal 
ettikten sonra arada yapılan işlemlerin ardın-
dan ara hamleleri geri almadan yeniden son 
haliyle seçimi aktif yapmak için bu komutu 
kullanabilirsiniz. Yapılan seçimleri Select> Save 
Selection komutuyla kaydetmenizi öneririz. 
Bazı kullanıcılar Make Work Path’i kullanıyor. 
Bu çok sağlıklı bir saklama yöntemi değildir. 
Çalışmanın hangi aşamasında kullanacağınızı 
kestiremeseniz de başka bir işlem için gerek-
li olabilir. Bunların yapılmaması durumunda, 
çalışma devam ederken en son aktif olmuş 
seçime ihtiyaç duyarsanız Select menüsüne 
bir göz atın. Reselect aktif görünüyorsa, tık-
lamanız yeterli olur.

Inverse: Çalışma içinde bir bölgeyi seçmiş 
olabilirsiniz. Seçimin dışında kalan pasif alan 

üzerinde bazı değişikliklerde bulunmak iste-
diğinizde seçimi kaldırmadan, seçimi tersine 
çevirmek için Inverse komutunu kullanabi-
lirsiniz. Load Selection penceresinde de bu 
komut bulunmaktadır.

Layer seçenekleri: Layer’lar bu yazının ko-
nusu değil. Bu sebeple çok kısaca bahsetmek 
istiyorum. Çalışma sırasında onlarca katman 
kullanmış olabilirsiniz. Layer paletinde bulu-
nan tüm katmanları seçili duruma getirerek 
All Layers komutunu kullanabilirsiniz. Deselect 
Layers ise ister bir ister tüm katmanlar seçili 
olsun; tüm bu katmanları seçili olmaktan çı-
karmak için bu komutu kullanabilirsiniz. Simi-
lar Layers, ise oldukça hoş bir özelliğe sahip-
tir. Katman paletinde birden fazla Adjustment 
Layer, Shape Layer, yazı katmanı vb. kullan-
mış olabilirsiniz. Aynı türdeki katmanları seç-
mek için kullanılır. Herhangi bir özelliğe sa-
hip bir katman seçin. Adjustment özellikleri-
nin kullanıldığı bir katmana tıklayıp, aynı ve 
benzer katmanları “seç” dediğinizde bu özel-
liğin kullanıldığı tüm katmanları seçebilirsiniz. 

Color Range: Kısaca renge duyarlı, kont-
rollü seçimler oluşturmak için kullanabilirsi-
niz. MagicWend’in gelişmiş bir versiyonudur.

Feather: Aktif bir seçim alanı olduğunu dü-
şünelim. Aktif olan bu seçim alanına renk dol-
durmak istediğinizde, kenar hatların yumuşak 
olmasını istiyorsanız, bu komutu kullanabilir-
siniz. Taşıma, rötuş, çok amaçlı bir kullanım...

Modify: Border, Smooth, Expand, Cont-
ract olmak üzere dört ayrı fonsiyondan oluşur.

Modify> Border; Aktif bir seçim alanının sı-
nırları üzerinde, vereceğiniz piksel genişliğin-
de özel bir alan oluşturur. Köşeli alanlarda ek 
bir düzeltmeye ihtiyaç duyulur. Kullanımı azdır.

Modify> Smooth; Yazımızın başında bah-
setmiştik. MagicWend, ColorRange gibi 
araçların yardımıyla renge duyarlı seçim ya-
pıldıklarında çözünürlük ve renklerin dağılımı 
sebebiyle hatlar düzgün seçilmemiş olabilir. 
Bu durumda Smooth’u kullanarak vereceği-
niz piksel değerlerinde hatların biraz daha 
düzgünleştirilmesini sağlayabilirsiniz. Çok 

SEÇİM TEKNİKLERİ 
FAYDALI NOTLAR

Matting> Defringe komutu, görselinin ke-
narlarında gördüğünüz saçak piksellerin si-
lenmesinde kullanmak üzere Layer> Mat-
ting> Defringe komutunu açıp 1 veya 2 pik-
sellik bir değer uygulayın. Şunu da unutma-
yın Defringe her zaman işe yaramaz. Defrin-
ge komutunu kullanırken vereceğiniz de-
ğerler görselin çözünürlük değerine göre 

değişir. Bazen 1 bazen 2 piksellik değerle-
ri kullanabilirsiniz. Bu tür saçaklar genelde 
MagicWend, Alpha kanalları gibi fonksiyon-
ların kullanılması sonucunda oluşur. Seçim-
lere deneyim kazandıkça işin başında bu tür 
ek müdahalelere gerek kalmadan işlerinizi 
sonuçlandırabilirsiniz.

Saçak Piksellerin Temizlenmesi “Defringe”
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kullanışlı ve ihtiyaç duyulan bir fonksiyondur.
Expand; Aktif seçim alanını vereceğiniz 

piksel değerinde genişletmek için kullana-
bilirsiniz. 

Contract; Aktif seçim alanını vereceğiniz 
pikseller değerinde içe doğru seçim alanı kü-
çülecektir. MagicWend ile yapılan seçimler 
sonrasında 1, 2 piksellik istenmeyen seçilmiş 
alanlar oluşmuş olabilir. Bu aktif alanların 
kaldırılmasında bir çözüm olarak Contract’ı 
kullanarak 1-2 piksel değerinde içe doğru 
seçimi küçültüp, küçük seçim alanlarını yok 
edebilirsiniz. Böylelikle hızlı bir şekilde seçim 
düzenlemesi yapmış olursunuz..

Grow ve Similar; Renge duyarlı seçimlerde 
oldukça kullanışlı iki fonksiyon. Herhangi bir 
seçim aracıyla belirli renk tonları seçildikten 
sonra, aynı katmanda farklı noktalarda benzer 
renkleri seçmek isteyebiliriz. Tekrar tekrar yeni 
seçim tıklamalarına gerek olmadan Grow ve 
Similar komutunu bu noktada kullanabilirsiniz. 

Aralarında çok temel bir fark vardır. Grow 
komutunu kullanabilmeniz için, seçili bulu-
nan renk tonları ile seçilmek istenen renkli 
pikseller arasında yine piksellerden oluşan 
bir bağ, köprü olmalı, ara bağlantıyı kesen 
her hangibir kontrast renk olsa dahi Grow 
komşu, yakın tonlu pikselleri seçmez. Similar 

da bu durum geçerli değildir. Aynı katmanda, 
farklı noktalarda, aralarında bağ olmasa dahi, 
bir birinden kopuk olmalarında seçili bulunan 
renkli piksellere yakın tüm alanları seç komu-
tunu verdiğinizde belirli bir tölerans değer 
aralığındaki pikseller seçime dahil olurlar.

Transform Selection; Katmanlarla çalışır-
ken kullandığınız FreeTransform aracının ak-
tif seçim alanı için kullanabileceğiniz çok ya-
rarlı bir araç. Seçime perspektif, bükme, bü-
yütme ve küçültme değişkenlerini rahatlıkla 
uygulayabilirsiniz.

Load Selection Save Selection; Onca çalı-
şıp hazırladığınız seçimlerinizi daha sonra tek-
rar kullanmak hatta, diğer seçimlerle birleşti-
rerek, yeni bölgeleri seçmek amacıyla sakla-
yabileceğiniz bir yer var. Alpha kanalları. Bu 
kanallara var olan seçimleri Select menüsün-
den ulaşabileceğiniz Save Selection komu-
duyla kaydedebilirsiniz. Kaydettiğiniz seçim-
leri istediğiniz zaman Load Selection ile tek-
rar aktif hale getirmeniz mümkün.

Load Selection komudunu kullandığınızda, 
çalışma alanı içinde bir seçim alanı varsa Ope-
ration seçenekleri aktif olur. Bu bölümde var 
olan seçim alanı ile, yeni aktif edilecek seçimin 
birleşmesini, bir birinden çıkartılmasını, ortak 
alanların kalmasını yönetebilirsiniz. Bu bölü-
münde fazla kullanıldığını düşünmüyorum.

PATH SEÇİM ARAÇLARI
Seçimleri genel çerçevede inceledikten sonra 
Photoshop’un vektörel kullanım araçlarından 
Path’i inceleyeceğiz. Path çizimi bir çok kulla-
nıcının ilk önce öğrendiği kullanım araçların-
dan biridir. Seçim çalışmalarında çoğunlukla 
tercih edilir. Kontrollü hatların oluşturulması, 
seçim çalışmasının her an yeniden kolaylıkla 
düzenlenebilmesi sebebiyle bir çok kullanıcı 
tarafından tercih ediliyor. Yalnız çoğunlukla 
tercih edilmesi her noktada işe yaradığını 
söyleyemeyiz. Bir çok noktada, kullanıcılar bu 
yazımda bahsettiğim diğer seçim tekniklerini 
bilmediklerinden her seçim çalışmasında Path’ı 
kullanıyorlar. Umarım bu yazımdan sonra diğer 
arça ve fonksiyonları kullanarak işlerinde daha 
da kolaylık gösteren araçları kullanabilirler.

Path Çizimleri ve Kontrolleri
Tool box üzerinde çizimlerle ilgili iki ana 

SEÇİM TEKNİKLERİ
FAYDALI NOTLAR

Seçim Yönetim Paneli: Refine Edge

Photoshop’un pratik bir program oldu-
ğunu söylerim. Pratik ve kullanıcı dostu bir 
program. Bunu, Refine Edge panelinde gö-
rebilirsiniz. CS3 versiyonuyla birlikte kulla-
nıcıların tercihe sunuldu. 

Bu panel, select menüsünde yer alan ko-
mudların, bir arada, aynı zamanda ve de-
ğerlerinin nesneye uygulanmadan önce, 
sonucunun izlendiği çok işlevsel pratik bir 
paneldir. 

Seçim alanına Feather vereceksiniz, kaç 
değer vermek gerekli, bunu değer girerek 
sonucu anında görüp, pencereyi kapatma-
dan, değeri düşürerek veya yükselterek aynı 

anda görmeyi, istediğiniz zaman seçim ala-
nına Quick Mask modundan ya da arka pla-
nı beyaz olarak görmenize yarıyor. Panel 
sağ alt köşesinde fare ile kontrollerin üze-
rine geldiğinizde seçeneklerin ne işe yara-
dığını gösteren küçük ikonlar ortaya çıkıyor. 
Böylelikle bu özellikleri ezberlemenize ge-
rek kalmadan pencereyi kullanabiliyorsunuz.

Seçim işlemlerinde, kullanıcının zaman 
kaybetmeden çalışması için en doğru de-
ğerlerde sonuç alması yönünde kullanışlı 
bir panel.

Bir çok kullanıcı tarafından halen keşfe-
dilmeyi bekliyor.
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araç grubu vardır. Bunlardan birisi Pen Tool 
araç grubu diğeri de bu çizimler üzerinde 
müdahale ve değişiklik yapmak için kullanı-
lan Path ve Direct Selection Tool araçları. Bu 
çizimlerin oluşturulması sırasında yaşanılan 
bazı sıkıntılar söz konusu. Aslında bunları 
problem olarak nitelemek yanlış olur. Özellik 
barından başlayan hazırlık sürecininin Path 
paletindeki özelliklerine kadar devam eden 
sürecin ardından yapılan çizimlerin istenildiği 
gibi seçilememesi kullanıcıların sıkıntı çektiği 
bir durumdur. Bunu çözmek için kimi zaman 
her şeyi silerek yeniden Pen Tool ile çizime 
başlıyorlar. Aslında yapılması gereken, özellik 
barında örnek ekran fotoğrafında gördüğünüz 
ikonlardan 4 numaralı olan Exclude Overlap-
ping Path ikonuna öncelikle tıkladıktan sonra 
çizimlerinizi yapmanız. 

Path paletinde çizimlerinizi oluştururken 

kendiliğinden Work Path oluşur. Size öneri-
miz, hiç beklemeden Work Path’in üzerine 
çift tıklayarak öncelikli olarak kaydetmeniz. 

Work Path ikonuna dikkat ederseniz, gri 
ve beyaz bölgeleri görebilirsiniz. Konumuzun 
ilk bölümünde maskeleri anlatırken seçimle-
rin siyah ve beyaz renklere göre yapıldığın-
dan bahsetmiş, bu renklerin seçimlerde ve 
saydamlık uygulamalarında belirleyici oldu-
ğunu söylemiştik. Örnek ekran fotoğrafında 
gördüğünüz biçimde bir path oluşturup se-
çime dönüştürdüğünüzde beyaz renkle gös-
terilen yerlerin seçime dönüştüğünü, gri böl-
gelerin seçim dışı kaldığını göreceksiniz. Bu 
mantığın Photoshop içindeki uygulamalarla 
bütünlüğünü göstermede güzel bir işarettir. 
Çünkü vektör mask uygulamalarında göre-
ceğiniz gibi, mask ikon görünümü Work Path 
üzerinde gördüğünüzle aynıdır.

Path çiziminize başlarken Add, Subtract, 
Intersect gibi fonksiyonlardan uygun birini 
seçmediğinizi düşünelim. Çiziminiz bittik-
ten sonra, çiziminizi seçime dönüştürmek 
istediğinizde ortaya farklı bir seçim çıktığını 
gördüğünüz de herşeyi baştan almaya ge-
rek yoktur. Burada yapmanız gereken, path 
çiziminizi seçerek, seçim fonksiyonların dav-
ranış özelliklerini değiştirmektir. Sonrasında 
seçiminizi tekrarladığınızda doğru bir seçim 
yaptığınızı göreceksiniz. Bu uygulama içinde 
örnek ekran fotoğrafını inceleyebilirsiniz. 

Yukarıdaki fotoğrafta, aynı path paleti 
üzerinde ikinci bir path çizimi yapılmış. Şu 
an ki davranış Intersect, yani (3) ortak alanla-
rın seçimi. Sizin bunu değiştirmek istediğinizi 
düşünelim. Dönüştürmek istediğimiz davra-

nış Add to path (1), yani dış alanların seçimde 
birleşmesi, çizimin içinde ayrı parça çizimler 
varsa da, bütüne dahil olarak seçim içinde kay-
bolması... Bu tür durumlarda Path Selection ile 
ekranda görünen tüm path çizimlerini tarama 

yöntemiyle seçin ve davranışlardan herhangi 
birine tıklayın. Seçim davranışı değişecektir.

Path Selection Tool: 
Ekranda aktif görünen Path grubu için-

deki bir path’i seçebilmek için ve sonrasın-
da grup olarak taşımak, transform aracıy-
la büyütmek ve küçültmek için kullanaca-
ğınız seçim aracı.

Direct Selection Tool:
Çizimleriniz noktalardan oluşur. Yapılan 

çizim üzerinde düzenleme, noktaların ko-
numlarını değiştirmek için, tüm yolu değil, 
referans noktalarını seçip gerekli değişiklik-
leri yapmak istediğinizde Direct Selection 
aracını kullanabilirsiniz. Seçtiğiniz noktalar 
köşe noktası (Corner) değil de yumuşak bir 
yayı oluşturan (Smooth) noktalar ise, nok-
taları seçer seçmez kontrol yayları çıkar. Bu 
yayları kullanarak kavisleri, hattın yumuşak-
lığını değiştirebilirsiniz.

PATH SEÇİM ARAÇLARI
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